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SOFTWARE END USER LICENSE AGREEMENT

PLEASE READ THE FOLLOWING TERMS AND CONDITIONS CAREFULLY. If you (end user, either an entity or an individual)
do not agree with these terms and conditions do not install the software. This End User License Agreement is a contract
between you and Philips Consumer Electronics B.V, including its suppliers and licensors (“Philips”) for this software program
(“Licensed Software”). By installing the Licensed Software or using the Licensed Software you agree to and accept the terms
and conditions of this End User License Agreement. YOU AGREE THAT YOUR USE OF THE LICENSED SOFTWARE
ACKNOWLEDGES THAT YOU HAVE READ THIS END USER LICENSE AGREEMENT, UNDERSTAND IT,AND AGREE TO BE
BOUND BY ITS TERMS AND CONDITIONS:

1. Copyright
The Licensed Software is a proprietary product of Philips, and is protected by copyright laws. Title, ownership rights and
intellectual property rights in and to the Licensed Software shall remain with Philips.

2. Right to use
Philips hereby grants you the personal, non-exclusive license to use the Licensed Software only on and in conjunction
with one (1) computer at one time.You may not sell, rent, redistribute, sublicense or lease the Licensed Software, or
otherwise transfer or assign the right to use it.You may not decompile, disassemble, reverse engineer, or in any way
modify program code, except where this restriction is expressly prohibited by applicable law. Except for one (1) copy
which may be made for backup purposes only, you may not copy the Licensed Software.You are not allowed to alter or
remove any proprietary notices, including copyright notices, in the Licensed Software.

3. Disclaimer of Warranty
THE LICENSED SOFTWARE IS PROVIDED AS ISWITHOUT WARRANTY OF ANY KIND.THE ENTIRE RISK OF USE
OF THE LICENSED SOFTWARE REMAINS WITH YOU.TO THE MAXIMUM EXTENT PERMITTED BY LAW, PHILIPS
MAKES NO FURTHER REPRESENTATIONS OR WARRANTIES EXPRESSLY OR IMPLIED SUCH AS BY WAY OF
EXAMPLE BUT NOT OF LIMITATION REGARDING MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR
PURPOSE, OR THAT LICENSED SOFTWARE IS ERROR FREE, OR THAT THE USE OF THE LICENSED SOFTWARE
ORANY COPIES THEREOF WILL NOT INFRINGE ANY PATENT, COPYRIGHT, TRADEMARK OR OTHER RIGHT OF
THIRD PARTIES.

4. Updated
This license does not grant you the right to any upgrades or updates of the Licensed Software. However, Philips will be
entitled to offer updates and/or modifications to the Licensed Software at its discretion.

5. Changes of the agreement
No changes of this Agreement are valid unless with Philips’ and your written approval. Any terms and conditions provided
by you are inapplicable, whether or not contained in order forms or otherwise, unless specifically accepted by Philips in
writing by means of a duly signed addition to this Agreement.

6. Limitations of liability
PHILIPS ACCEPTS NO LIABILITY FOR ANY DAMAGES, INCLUDING ANY LOSS OF PROFIT, LOSS SAVINGS, LOSS
OF DATA, BUSINESS INTERRUPTIONS, OR ANY DIRECT, INDIRECT, INCIDENTAL, CONSEQUENTIAL, SPECIAL OR
PUNITIVE DAMAGES ARISING OUT OF YOUR USE OR INABILITY TO USE THE LICENSED SOFTWARE, EVEN IF
PHILIPS OR ITS REPRESENTATIVES HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY
CLAIM BY ANY OTHER PARTY. SINCE SOME JURISDICTIONS DO NOT ALLOW THIS LIMITATION OF LIABILITY,
THIS LIMITATION OF LIABILITY MAY NOT APPLY TO YOU.

7. Validity and Termination
The license granted hereunder shall terminate automatically and without notice if you do not comply with all the terms
and conditions of this End User License Agreement. In the event of termination, you shall immediately stop any use of the
Licensed Software and destroy all copies thereof. In addition, in the event of termination because of your failure to com-
ply with your obligations, Philips reserves the right to invoke any and all other remedies available to it in law or contract
including the right to claim damages.

8. Applicable Law
This contract shall exclusively be governed by the laws of the Kingdom of The Netherlands without regard to its conflict
of law provisions.

9. Competent Court
The competent court for any dispute between you and Philips pursuant to this End User License Agreement is the court
of ‘s-Hertogenbosch, the Netherlands.

© Philips Consumer Electronics B.V., 1999, Eindhoven, The Netherlands
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Introduction

CONGRATULATIONS ON YOUR PURCHASE OF THE
PHiLIPS RHYTHMIC EDGE™ SouND CARD!

Thank you for enhancing your computer with the Philips Rhythmic Edge ™.
We know you'll agree, once you give it the edge, that your PC will never sound the
same again.

Now get ready to ignite your imagination with the most immersive soundstage ever
created onaPC ...

... a full-blown, digital surround-sound, quadraphonic home theater experience
through your new Philips Rhythmic Edge Sound Card. Philips sound cards are the first
to deliver the impact of 4 distinct channels of sound from every application. Utilizing
advanced digital signal processing algorithms and extreme hardware acceleration,
Rhythmic Edge extracts audio-phile-quality sound from your PC with no added strain
to your processor — not just from DVD’s or 3D audio games but from all your
games, music and movies.

Load your favorite music, games and movies and be prepared to hear every detail as
never before articulated through 96 distinct 3D voices, 256 distinct DirectSound
voices and 576 distinct synthesized Wavetable voices.

The heart of your sound card is Philips’ powerful new ThunderBird Avenger audio
processor, which relieves your computer of performing enormously complex audio
processing. The results are dramatically faster, more-responsive gaming effects and
more-convincing three-dimensional audio sound fields, all without placing new
demands on your computer.

Advanced DSP algorithms from QSound Labs provide rich three-dimensional sound
for every application. If you have headphones or only two speakers, Rhythmic Edge’s
patented psycho-acoustic codes envelop you in a virtual sound field created from up
to ninety-six independent 3D voices.

Add surround speakers, and Rhythmic Edge will transform your PC into your
personal home theatre system, fully capable of playing the very latest Hollywood
DVD releases in full-blown digital glory. Take your music CDs, MP3s, video files, cut
scenes and stereo games to the max while you're at it — rediscover your existing col-
lection while you add new favorites too!

Rhythmic Edge truly revolutionizes PC sound. Install your sound card as directed,
connect a 4 channel surround speaker system and try these:

 Play the latest Hollywood DVD hit and be prepared for goosebumps as sound
effects sweep you away.

= Rediscover your favorite music in a whole new dimension — even those golden
oldies. You've never heard them like this before!

 Play a 3D audio-enabled game and experience what "virtual reality" can mean.

« Elevate your classic 2D games to a whole new level of audio realism.

* Compare enhanced QMSS to ordinary Dolby Digital on DVD and hear the
remarkable differences.

Key FEATURES
* 256 streams of DirectSound acceleration and digital mixing

* 96 streams of 3D audio acceleration including positional reverb, obstruction
and occlusion

e Full-duplex, 48khz digital recording and playback
 Philips ThunderBird Avenger™ high performance audio accelerator

» Hardware DSP accelerated QSound 3D algorithms including
QSound3Dinteractive™ positional 3D
QSound Environmental Modeling for EAX™ and DS3D™ games
QSound Multi Speaker System™ for quad output of stereo sources
QXpander™ for 3D enhancement of stereo
DVD QSurround™ 5.1 speaker virtualization over stereo speakers

* 576 voice total wavetable synthesis music polyphony
512 Voice professional quality soft-synth with XG and GM compatibility
64 channel hardware wavetable synthesizer

= Dual gameport accelerator with legacy and digital joy-stick modes

e DirectSound™, DirectSound3D™, EAX™ 1.0 , EAX™2,0/I3D Level 2, and A3D™
1.0 compatibility

« Stereo, 4 channel surround speaker or headphone output
e QMSS™ enhanced DVD playback mode (compatible SoftDVD player required)
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Introduction

MINIMUM SYSTEM REQUIREMENTS

Installation of your Philips Rhythmic Edge™ requires the following minimum hard-
ware and operating system:

e One available PCI 2.1 compliant slot

« Intel Pentium® class or 100% compatible 166MHz or faster processor

e Intel® or 100% compatible motherboard chip set

e 16MB system RAM

e CD ROM for driver installation

e Stereo, 4 channel surround powered speakers or headphones

e Windows® 95, Windows® 98, Windows NT® 4.0 (SP3)*, Windows® 2000,
Windows® Me

WHAT’S INCLUDED
You will find the following items in your Rhythmic Edge™ package:

1 — Rhythmic Edge™ sound card in a anti-static pouch

1 — Rhythmic Edge™ installation CD

1 - Analog audio cable to connect CD/DVD drive to sound card

1 - Line Out cable

1 — Rhythmic Edge™ user’s manual

1 — Product registration card

Bundled applications may be included on the installation CD or on separate media
depending on the Rhythmic Edge™ maodel.

Please retain the Yamaha Certificate of Authenticity. The included serial number will
be needed during software installation.

* Not all product features supported using this operating system.

WHAT YOU NEED FOR INSTALLATION

Computers come in different shapes and sizes. The installation procedures in this
manual apply generally and you should compare the illustrations here with your
computer before you start your sound card installation.

» Sound card

e Installation CD

e CD Analog Audio Cable
= Line out Cable

* A Phillips screwdriver

Have your Windows® installation CD available as it may be needed to complete
installation of common software components.

Video Guide

A 3-part video installation guide can be found on the Acoustic Edge Installation CD:

If CD/DVD autorun is enabled, a Philips Edge Series Autorun window will pop up
when the CD is inserted into the CD drive. Then click on the “View
PSC703/PSC705 Installation Videos" icon from the window. Another Philips Edge
Series AutoRun window will pop up; click on either Part 1: Introduction.mpg, Part 2;
Hardware.mpg, Part 3; Software.mpg, depending on which part you want to view.

If CD/DVD autorun is disabled, double-click on “autorun.exe”, located in the root
directory of the Philips install CD, or run it from the Windows-Start/Run menu.
Another way to manually start is by double clicking on Desktop/My Computer, then
click on the Philips Edge icon. Once the Philips Edge Series AutoRun window pops
up you may make the same choices as stated above (Part 1: Introduction.mpg, Part 2:
Hardware.mpg, Part 3: Software.mpg)

giiditihmicledgel o



Installing Rhythmic Edge

INSTALLING THE SOUND CARD

Uninstall the drivers for any previously installed sound cards.
Consult your previous sound card documentation for details.
Turn off computer and remove existing sound card.

If your computer has on-board sound, consult your PC
documentation to disable it.

STATIC ELECTRICITY CAN CAUSE PERMANENT DAMAGE
TO YOUR SOUND CARD

To prevent damage please:
1. Always hold your sound card by its edges. Avoid touching any electronic
components on your sound card.

2. Use a grounding strap or touch any non -painted surface of your
computer chassis before you begin installation to discharge
static electricity.

TO INSTALL THE SOUND CARD:

Turn off your computer, and disconnect the power cable.
Disconnect all devices that are connected to the computer.

Remove the computer cover.

Select an available PCI slot and, if necessary, remove its cover plate.

Keep the mounting screw to secure your sound card later. Save the mounting plate
for possible use later.

PCI Bus Slot



Installing Rhythmic Edge

Remove the Rhythmic Edge™ Sound Card from the anti-static bag. Align your sound
card with the selected PCI Bus-Slot and firmly push it into the slot. Be sure the
sound card is aligned properly and fits snugly into the slot.

Sound Card
Top & Bottom View

Mounting Screw

I_'ﬁ

Use the screw from the slot cover to secure the sound card to the frame
of the computer chassis, but do not over-tighten. Securing the card assures
proper grounding.

PCI Bus Slot

SOUND CARD CONFIGURATION (ACTUAL CARD LAYOUT MAY VARY)

Analog
AUX In TAD CD IN

o T (T il

" PHILIPS

IR 111

[ S e T TN

END BRACKET CONFIGURATION Line In
Mic In
Front Out
Rear Out
S/PDIF
CD ANALOG CABLE (Coax)
Ey - = —-:_-
,.-"'_ Game/Midi
Port
| y/




Installing Rhythmic Edge

CONNECTING TO YOUR RHYTHMIC EDGE SOUND CARD

Speakers

Connect your front speakers or headphones into the FRONT OUT stereo jack on
the end bracket. Connect your rear/surround speakers to the REAR OUT stereo
jack on the end bracket. If you are using a pair of digital (S/PDIF) speakers for your
front or rear speakers then plug them into the S/PDIF Out phono jack as indicated
below.

S/PDIF

To connect digital speakers, an AC3 or DTS decoder, receiver or other device to to
the S/PDIF out of the sound card, plug it into the S/PDIF jack on the end bracket.

Line In, Mic In and MIDI/Joystick

External analog stereo sources with line level output can be connected to light blue
3.5mm stereo jack at the top of the sound card bracket. A microphone can be
connected to the pink 3.5mm mono jack. An analog or digital joystick and/or MIDI
devices can be connected to the large connector at the bottom of the bracket.

Internal Connections

Connectors for three line level analog inputs (Aux In, TAD, Analog CD In) are
provided along the top of the sound card as indicated in the picture on page 16.
Use the 4 pin CD audio cable to connect the analog audio output of your internal
CD or DVD drive to the sound cards "Analog CD In" connector.

Replace computer cover and reconnect the power cable, monitor and other devices.

SOFTWARE INSTALLATION

WINDOWS® 95/98/Me/2000 INSTALLATION

Now that the hardware is installed, it is time to configure the drivers.
Plug and Play uses your system’s BIOS and the Plug and Play features of
Windows® 95/98/2000 to allocate resources for Philips Rhythmic Edge™.

Which version of Windows do you have?

Microsoft issued a maintenance release of Windows® 95 referred to as OSR2.

This version shipped as the stock operating system on many PC's. Newer and
recently upgraded PC'’s will have the Windows® 98 operating system. Other systems
will have the original Windows® 95 or “Gold” version. The following procedure
describes installation using Windows® 98/98SE. Windows® 2000 screens are slightly
different but the procedure is the same as described. If you have older versions of
Windows® 95 then the installation will be slightly different than described below.

A= cEEe 6@



Installing Rhythmic Edge

To install the drivers for Windows® 95/98/Me/2000
1. Turn on the computer and place the Philips Rhythmic Edge™ CD in your
CD-ROM drive.

When the Add New Hardware Wizard dialog box reports that a new PCI
Multimedia Audio Device has been detected, click NEXT.

Add Mew Hardware Wizard

Thiz wizard zearches for new drivers for:

PCI Multimedia Audio Device

A device driver iz & goftware program that makes a
hardware device work.

Cancel

Select Search for the best driver for your device (Recommended).
Click NEXT.

Add MNew Hardware Wizard |

What do pou want Windows to do?

% Search for the best driver for your device.
[Fecommended].

" Dizplay a list of all the diivers in a specific
location, 20 pou can zelect the driver pou want,

< Back I Mext = I Cancel

A= cEEe €@



Installing Rhythmic Edge

3. If you are installing from the install CD or if you have copied the install to any 4 Select NEXT to install the drivers.
other location, select SPECIFY A LOCATION and browse to your directory
where the setup files are located. For Windows® 95/98/Me, select Win9x A Mo At |
directory then choose english. For Windows® 2000, select WDM directory.

. Windowes diiver file search for the dewvice:
Click NEXT.

Philips PSCF03 Audio

Add New Hardware Wizard

Windows will search far new drivers in it driver database
an your hard drive, and in any of the following selected
lozationz. Click Mext to start the search.

YWindowes iz now ready to install the best driver for this
device. Click Back to zelect a difterent driver, or click Mest
to continue.

Lozation of driver:

[T COROM dive

@ D:AWINIMENGLISHAVOEMSETUR.INF

[ Microsoft Windows Update

¥ Specify a location:
| D INSRENGLISH =]

Browee. .. |
< Back I Mext = I Cancel |

Cancel

phdthmicledgel 1o |



Installing Rhythmic Edge

5.

Windows® then copies the files. You may be prompted to insert your
Windows® CD or floppy, as the core sound components of the operating
system may need to be copied as well. These include audio Codecs, the Mixer
and the Sound Recorder program.

Copying Files._.

Source:

Lo b INEMENGLISHATEIRD 1 28.0LS
Destination:

LMD DWW SASYSTEMATEIRD1 28.0LS

=

The installation will continue to install the files to your system.
For Windows® 95/98/Me,

Click FINISH.

For Windows® 2000, you must install the Philips Rhythmic Edge Audio™
and Philips Rhythmic Edge GamePort Enumerator devices. Browse to
the Driver disk directory WDM\English to install these files. You will find these
files in the same WDM install directory and Windows® will finish installing the
drivers for Philips Rhythmic Edge™ automatically.

Click FINISH on each screen to install each of these devices.

Add New Hardware Wizard

Philips PSCF03 Audio

Windows haz finizhed installing the zoftware that pour new
hardware device requires.

< Hanh Cancel

A= cEEe @



Installing Rhythmic Edge

7. After clicking “Finish” the Philips Rhythmic Edge™ GamePort will be installed. It
is possible during gameport installation, Windows® will detect newer versions of
msanalog.vxd, vjoyd.vxd and msjstick.drv. It is recommended that you keep your
existing files. Click YES on all 3 screens that appear.

Yersion Conflict E3 |

A, file being copied iz older than the file currently an your
computer. [t iz recommended that pou keep vaur existing file.

File name: mzanalog. wxd

Dezcrption: Analog Jopstick Yirtual Device

Your vergion:  4.05.7.1993

Do you want to keep this file’?

Ho [ b ||

8. Next, the software launcher will allow you to open the Rhythmic Edge control
panel and configure your speaker settings if desired. Select YES to modify these
settings now, or select NO to modify later. Speaker settings are described
under the Settings Tab in this manual.

i Applications Launcher ¥1_16

@ "Philips PSCY03 Audio Contral Panel”

Thiz application will allow pou to
zelect your speaker configuration.

Do pau wish ta run thiz application?

Note: Any time you say No to a Applications Launcher dialog box like the one shown
above, a second box will appear asking if you want to launch the next time Windows is
started. Answer Yes or No as desired.

9. Next, the DirectX® Setup dialog box will appear. Click OK.

DirectX(R) Setup ]|

Dptiong
’7 ¥ Direct3D Hardware &cceleration Enabled

Relnstall Direct

EEstare S divers | k. |
Cancel |

Eestare [Wieplay divers
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Installing Rhythmic Edge

YAMAHA SOFTSYNTHESIZER INSTALLATION

10. After Rhythmic Edge™ driver installation, the software launcher will prompt you
to install the Yamaha SoftSynthesizer. Click YES.

i Applications Launcher ¥1.12 E2 |

2)

"“ramaha SoftSynthesizer S-r=GEE0 [nstall”

Do you wizh to inztall this application?

11. The Yamaha SoftSynthesizer Welcome page appears. Click NEXT.

Welcome

Welcome to the S-YXG50 Setup program.  This
program will inztall 5-v=E50 on your computer.

[t iz strongly recommended that pou exit all Windows programs
before running thiz Setup program.

Click Cancel to quit Setup and then close any programs vou
have mnning. Click Mext to continue with the Setup program.

WARMIMG: Thiz program iz protected by copyright law and
international treahies.

Unauthorized reproduction or distnbution of thiz program, or any
poition of it, may rezult in zevere civil and criminal penalties, and
will be progecuted to the maximum extent pozsible under law.

Cancel |

12,

Enter the serial number located on the Yamaha Corporation Certificate of
Authenticity included with your documentation. This serial number is case

sensitive!

Click NEXT.

Uzer Information

Fleaze enter your name, the name of the company far whan you
work, and the product genial number.

Company: ||

< Back I L= I Cancel
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Installing Rhythmic Edge

13. The Choose Destination Location dialog box appears. Follow the instructions 14. Select A Program Folder dialog box appears.
in this box. Click NEXT
Click NEXT

Select Program Folder x|

Choose Destination Location

Setup will add program icons to the Proaran Folder listed below,
You may type a new folder name, or select one from the existing
Folders lizt. Click Mext to continue.

Setup will inztall 5-v=G50 in the following folder.
Tainztall ta this folder, click Mest.

Tainztal to a different folder, click Browse and zelect another

falder. Erogram Folders:

Y'ou can chooge not to ingtall 5-7=G50 by clicking Cancel to exit
Setup.

Fow Interactive
Heavy Metal - FARKZ

e Hi 2K HyperCD
Destination Folder Imteryiden WinDwD
CAYAMAHANSYXG50 Browse..._| lomega e =

< Back I Hewt » I Cancel |
Cancel |

< Back

phdthmiciedgell 27 |



Installing Rhythmic Edge

15. The Yamaha Software License Agreement dialog box is displayed. If you accept 17. Product Registration — If you are connected to the internet, you can register
the terms and conditions, Click YES. your product now by clicking YES in the dialog window shown below.

If you prefer to register your product at a later time, go to:

1 = . . .
Softwars Licansa & o) x| www.philipsusa.com/prod_reg_bounce.html and follow the instructions.

@ Fleaze read the following Licenze Agreement. Press the PAGE DOWM key to see

th bl th L.
SIS e i Applications Launcher ¥1.14 E=
rhkAHA "SOFTSYNTHESIZER"TH 5-v3G50 3.0 LICHESE AGREEMENT ﬂ @ "Ehilins Product Registration wWebsite'
IMPORTAMT-READ CAREFULLY: This YakMAHA License Agreement [“AGREEMENT")

e can uze pour Intermet browser to take pou

iz & legal agresment to the Philips Product Registration 'ebsite.

between pou [either an individual or a zingle entity] and rakAHA for S4%G50 w3.0
identified above which may include azsociated software components, media, printed

: . S
materialz, and "online or electronic documentation ["'SOFTWARE FRODUCT™). By RDCEIE Ol TR .37 0

inztalling,

copying, of othensize uging the SOFTWARE PRODUCT. pou agree to be bound by the Ma |

termns of

thiz AGREEMEMT.

If you dao nat agree to the termis of this AGREEMEMT, dao nat install or uze the

SOFTWARE . L. .

PRODLICT. - Installation of Additional Software Packages (such as Siren XPress)
Follow these steps to install Siren XPress (or any other included software package).

Do you accept all the terms of the preceding License Agreement? If you choose No, Setup Siren XPress allows you to play and organize music

will cloze, Toingtall S-47=G50, pou must accept thiz agreement.

| 1. Insert your installation CD into your CD drive.

< Hack Yes Mo
2.From the Start Menu select Run and type D:\Applications\Sonic Foundry\Siren\
(D: represents your CD-ROM drive).
16. You must restart your computer at this time. Click OK 3. Double click on Sirensetup.exe
4. Follow the on-screen instructions for installation.
Setup has finished copying files to your computer. Before you can Congratulations!

use the program, you must restart Windows or pour computer,

You have successfully installed your Philips Rhythmic Edge™.
Chooze one of the follawing options and click 0K ta finish setup.

& ez, | want bo restart my computer now

™ Mo, | will restart my computer later.

phdthmicledgel 2o |



Installing Rhythmic Edge

WINDOWS NT® INSTALLATION

Installation of the drivers for your Philips Rhythmic Edge™ in a Windows NT® envi-
ronment are as follows (note: you must have the appropriate privileges in order to
install the drivers):

1. Boot the system to the Windows NT® desktop and insert your install CD in
your CD-ROM.

2. Go to D:\NT40\English and double click on Philips Rhythmic Edge Install.exe.
(D: represents your CD-ROM drive).

3. Wait a couple of minutes while the data transfers. Once it finishes the Philips
Rhythmic Edge Settings window will appear. Click OK on the settings page and
then when the “System Settings Change” page comes up and prompts you to
restart, click the “Restart Computer Now” button.

That’s it! Once the system reboots to Windows NT® your Philips Rhythmic Edge™
should be fully functional as indicated by the Windows® Startup sound.

YAMAHA SOFTSYNTHESIZER INSTALLATION FOR WINDOWS NT®

Follow these steps to install the Yamaha SoftSynthesizer from your install CD:
1. Insert your install CD into your CD drive

2. Go to D:\S-yxg50\Nt40\Disk1\ (D: represents your CD-ROM drive)

3. Double Click on Setup.exe
4

Follow the on-screen instructions for installation. The required serial number is
located on the Yamaha Corporation Certificate of Authenticity included with
your documentation.

SIREN XPRESS INSTALLATION FOR WINDOWS NT®

Follow these steps to install the Siren XPress. This application allows you to play and
organize music.

1. Insert your install CD into your CD drive

2. Go to D:\Applications\Sonic Foundry\Siren\ (D: represents your
CD-ROM drive)

Siren XPress Installation for Windows NT® (cont)
3. Double Click on Sirensetup.exe

4. Follow the on-screen instructions for installation

ReAL MobE DOS INSTALLATION (OPTIONAL)

This step is only required if you intend to run DOS applications under real DOS
mode by restarting your computer in “MS-DOS mode”. This step is not required to
run DOS applications in a DOS box (MS-DOS prompt).

In real DOS mode, you must have your DOS CD-ROM drivers loaded for access to
the install CD. Another way to do this is to simply run INST_DOSBAT from a DOS
box in Windows.

Run INSTALL EXE from the DOS directory on the CD. This installation program will
create the TBird directory on any drive you desire. Follow the screen prompts to
install the files to your hard drive. The install program will edit your autoexec.bat file
to perform automatic initialization of Philips Rhythmic Edge™ for use in real

mode DOS .

Using the Philips Rhythmic Edge Control Panel for DOS
To launch the DOS control panel:

1. Go to C\PSC703\ (C represents you hard drive)
2. Type VOLCNTRL.EXE

This application allows you to adjust volume levels, balance, input levels,
synthesizer modes, speaker modes, and midi effects in real DOS.

In DOS games that have music settings, if you select FM synthesis in the game, make
sure the synth control in the control panel is set to OPL3. For games that support
MIDI (mpu-401), select the WVTBL (wavetable) option. The game publisher normal-
ly has this information in the program documentation.

NOTE: This application is for real MS-DOS mode only and should not be run under
Windows. InWindows®, use the Windows® mixer for adjusting playback and
recording levels.
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Installing Rhythmic Edge

JoysTick CONFIGURATION FOR WINDOWS® 95/98/Me/2000: 2. Select the GENERAL tab and click the Add button. You may select any one of
1. Open the Control Panel and double-click on the GAME CONTROLLERS the GAME CONTROLLERS listed, then click OK.

icon. Select the ADVANCED tab and under PORT DRIVER ASSIGNMENT

and select Philips Rhythmic Edge GamePort.

FJ,. Game Controllers EHE |

General Advanced |

F.!. Add Game Controller 7] |

% To add a game controller, select the controller below and click OF.
— Controller [0 Azzignment

To modify the controller [0, select the D and click Change. Game Conbrollers:
: T
10 | h amne | Gamme Controllers | - 2-avis, 4-button joystick
1 ick. Z-awig, A-button joystick 2-buttan flight wake
2 [none) [none) | 2-button flight poke wthrottle
K] [rore] [home] 2-button gamepad
4 [hohe] [nore] 3-awiz, 2-button joystick
5 [nane) [nane] -axiz, 4-butkan iowstick LI
B [mone) [nore] j [ Rudder/Pedals

[F wour game controller does not appear in the lizt above, click Add Other.

Chanae... |

LCuztomn... | Add Other... |
— Port Driver Aszignment

If yaur game cantroller part requires a specific part diver, select it fram

the lizt below. QK I Cancel |

Poit Diiver: | Philips PSC703 GamePort =]

phdthmicledgel s: |



Installing Rhythmic Edge

3. After making your selection, highlight the selected controller in GAME
CONTROLLERS and click the PROPERTIES button. Select CALIBRATE and
calibrate your joystick. Your joystick should be installed and ready for flight!

Game Controller Properties K E

.-| Test I

Game Controller Calibration

If your game contraller iz not functioning propery on the Test page. it may
need to be calibrated.  Click Calibrate and follow the instructions to calibrate

the controller.
LCalibrate. .. |

(] I Cancel Sppli

Technical Support

Before calling the technical support number please make sure you have the
following information available:

* Model number and date of purchase.

* Computer type, processor speed, and memory available.

e Computer Operating System (IE: Windows® 95, Windows® 98, etc.)
e On-screen error information.

= Other hardware connected to your sound card.

Technical Support Information:
 Toll-Free Telephone Number: 1-800-835-3506

Operating Hours (US Central Time):
e Monday through Friday 7:00am — 11.00pm

e Saturday & Sunday 8:00am — 10:.00pm

Internet Address: www.pcsound.philips.com

Product Return

Before returning the Philips sound card, you must first contact the Philips Technical
Support group to determine the nature of product defect. Once the nature of the
problem has been determined, a Return Authorization number and address

will be supplied. A RETURN AUTHORIZATION NUMBER MUST
ACCOMPANY THE RETURN OF THIS PRODUCT.

When returning the product for service:

e The cost of shipment is at your expense and you assume all the risk. It is
recommended to ship the product through a carrier that provides proof of
delivery and product should be insured.

« Return Authorization number must be clearly marked on the outside of
the package.

* Use proper packing materials for shipment
e A dated proof of purchase proving the product is still under Warranty
Warranty: 3-year limited warranty
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DSP Special Effects and Algorithms

PHiLIPS RHYTHMIC EDGE™ DSP SPECIAL EFFECTS AND ALGORITHMS

EAX™ Game Compatibility (Effects Tab)

The Rhythmic Edge uses QSound Environmental Modeling™ (QEM™) to achieve
compatibility with games utilizing EAX™ 1.0 or EAX™ 2.0 properties including
environmental reverb, obstruction and occlusion modeling. EAX™ is a trademark of
Creative Labs.

DVD QSurround™ (Settings Tab)
Provides virtual 5.1 playback using just stereo speakers and a compatible soft-DVD
player capable of providing 5.1 output.

QSound Environmental Modeling™ /QEM™ (Effects Tab)

QSound Environmental Modeling (QEM) provides EAX game compatibility and the
ability to apply reverb to non-EAX sound sources including applications, S/PDIF In
and external inputs.

QSound Multi-Speaker System™ /QMSS™ (Settings and S/PDIF Tabs)
QMSS (QSound Multi-Speaker System) transforms stereo sources into 4 channel
output. QMSS is automatically invoked for stereo applications if 4

speaker mode is selected for all operating systems except Windows® 2000 (WDM
drivers). For Windows® 2000 (WDM drivers) the "Expand All" box must be
checked before starting the application. QMSS will also be applied to analog inputs
(CD In, Line In, etc.) and the S/PDIF In if enabled on the control panel.

QSound3DlInteractive™/Q3DI™ (Automatic)

Q3D positions sounds all around you using stereo or surround speaker systems or
headphones when playing 3D audio enabled applications. The proper DSP
algorithm is automatically selecting based on your speaker mode.

QXpander (Settings Tab)
QXpander widens the sound field of stereo music and provides 3D enhancement to
2D audio games when using stereo speakers.

Tone Control (Settings Tab)
Allow you to adjust treble and base levels to your personal taste.

Control Panel

HeLP BUTTON

Click the blue “Help” button on any tab and you will have access to comprehensive
hyper linked help file describing the control panel. Within the help file you can
navigate by simply clicking on parts of the image of the control panel, searching or
by using contents or index lists.

UTILITIES TAB
Windows® Audio Applications

g Philipz PSC703 Audio Control Panel

Ltilties |Settings| SIPDIF | Effects | MIDI | Speaker Test | Information |

CEE

Yolume Sound  Media Plaper  CD Plager  Multimedia
Cantrol Recaorder Properties

o v

SpaceJunk  Wumpus

¥ Show Control Panel lcon in the TaskBar

Ghgthmicledge)
PHILIPS

Cloze |

Volume Control:
Windows® audio mixer for adjusting volume of various sound sources.

Multimedia Properties:
Windows® utility for selecting multimedia devices. Use it to switch between the
Rhythmic Edge’s two MIDI music synthesis engines. (See “MIDI Tab” section)

Sound Recorder, Media Player & CD Player:
Windows® playback and record applications.
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Space Junk & Wumpus:

3D audio applications that demonstrate QSound Lab's 3D audio technology.
You must have the Rhythmic Edge install CD in your CD-ROM drive to launch
these applications.

Show Control Panel Icon in the TaskBar:
Enabling this allows you to open the control panel from the taskbar. Default
setting is enabled.

SETTINGS TAB

This tab allows you to select your exact speaker configuration and provides you
with sliders for adjusting the master volume, left/right speaker balance, fade

control (balance between front and back speakers), and Tone Control which affects
all channels.

g Philipz PSC703 Audio Control Panel M=l B |

Ltiities  Seftings |st|F | Eftects | MDl | Speaker Test | Information |

—Ooutput Contral
Balance Detault
L R | B |
[Cutput Mode Prerrpree —Tone Cortrol—
™ Headphaone rrade— viollme ™ Enable
2 Speakers haster Trebler Bass

0| GiFpanter
|l e e
(v 4 Speskers

11111 -

—

Il

Apply ReverbiaEpander 2MES to External Input Source: 2D
phagthmic

Cloze

a1

OuTtrPUT MODE

Headphone
Select this mode when listening using headphones rather than speakers. The head-
phones should be plugged into the “front” speaker jack.

Selecting “Headphone” tells the sound card to use a special 3D algorithm when play-
ing 3D games. Selecting “2 Speakers” will result in incorrect sound positioning when
using headphones. Selecting “Headphones” when using speakers will reduce the
effectiveness of 3D effects.

Note: The Rhythmic Edge is designed for use with headphones or amplified (powered)
speakers. Use with passive (non-amplified) speakers is not recommended.

2 Speakers

Select this mode when using stereo (2 or 3 piece) speaker systems. The Rhythmic
Edge will apply advanced 3D algorithms to virtualize sounds all around you when
playing compatible 3D audio enabled games.

QXpander

QXpander widens the sound field of stereo music and provides 3D enhancement
to 2D audio games. Using this feature in combination with speakers providing
“3D enhancement” may cause distortion and is not recommended.

DVD QSurround

This feature will greatly enhance your listening experience when used during
DVD playback in 2 speaker mode. This feature will provide the sensation of a
full-blown 5.1 speaker system by virtualizing the surround speakers. For proper
operation 5.1 output must be selected in the soft-DVD player’s control panel.

QSurround requires a soft-DVD player capable of providing 5.1 channel output.
If your soft-DVD player does not offer 5.1 output mode then select “stereo’ or
“Pro-Logic mode” in the soft-DVD player’s control panel and select QXpander
mode instead of DVD QSurround.

The Rhythmic Edge supports numerous playback modes for various speaker
configurations. See the “DVD Playback Modes” section of this manual for details.
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4 Speakers

Select this if you have a 4 or 5 piece speaker system (stereo front left and right and
rear/surround left and right speakers and optional subwoofer). 3D sounds generat-
ed by compatible applications will processed to the appropriate speaker and stereo
sounds from applications will be expanded to four distinct channels using QMSS.

Stereo sources from external inputs (CD In, Line In ...) will not be expanded to the
rear speakers unless the source is selected in the “Apply Reverb/QXpander/QMSS
to External Input Source:”.

If your front or rear speakers are digital (S/PDIF) rather than analog then see the
“S/IPDIF” section of this manual for additional instructions.

Expand All (Windows® 2000/WDM drivers only)
Select "Expand All" before starting the application to transform stereo applications to
4 speaker playback. This occurs automatically in other operating systems.

OuTtrPuT CONTROL

Balance Slider

Use this slider to adjust the relative volume of the right vs. left speaker. The overall
volume will not be affected. To center the balance slider automatically, right click on
the balance slider, and choose “Center”.

Fade Slider

Use the slider to adjust the relative volume of the front vs. rear speaker.
To center the fade slider automatically, right click on the fade slider, and
choose “Center”.

Volume Sliders

Master: To adjust the volume output for the master volume
(all speakers affected).

Tone Control

Treble and/or Bass level can by emphasized by checking the “Enable” box and adjust-
ing the Treble and/or Bass sliders. Uncheck the “Enable” box or adjust the sliders to
the bottom for a flat response.

Default Button
The default button will disable tone control and set Tone Control sliders to
minimum (flat). All other sliders under “Output Control” are centered.

Apply Reverb/QXpander/QMSS to External Input Source

Reverb, QXpander (when enabled), and expansion of stereo to 4 channels (QMSS)
are automatically applied to all sounds generated by applications running on your PC
however they are not applied to inputs such as analog “CD In” and “Line In” unless
that input is selected on the “Apply Reverb/QMSS/QXpander to External Input
Source “ selector pull-down menu.

A= cEEe @



Control Panel

For example if you are using the Microsoft “CD player” which uses the analog “CD
In” connector to play CD’s or if you are using a tape deck or other external device
connected to “Line In” you must select the input here to enable conversion of these
stereo sources to 4 channels using QMSS. However if you are using an application
that is not dependent on these connections such as a game, MP3 player, or a CD
player that uses digital extraction rather than analog “CD In” (such as the included
Siren JukeBox application) then QMSS is used to automatically convert these sources
to 4 channels (when in 4 speaker mode).

S/PDIF TaB

This page of the Philips Rhythmic Edge Control Panel will control the settings for the
Digital Audio output. S/PDIF is the acronym for industry-wide standard called
Sony/Philips Digital Interface.

= Philips PSC703 Audio Control Panel o) x| |

Utilties | Settings  S/POIF |Effen:ts|ru1IDI | speaker Test | information |

—SPDIF Ot

~ Front Left and Right Channels
" Rear Left and Right Channels

 D%D AC3DTS Pass-Thru

Ghgthmiclecge
PHILIPS

Cloze

i B

S/PDIF OuTt

Disabled
In this mode S/PDIF Out is disabled. Select one of the following options to
determine what content will be sent to the S/PDIF Out connector.

Front Left and Right Channels

In this mode the same content being sent to the front Line Out speaker jack in
analog format will also be sent to the S/PDIF output in digital format for applications
running on your PC (MP3, games, etc.). For external inputs (CD-In or Line In), select
the proper source on the "Apply Reverb/QXpander/QMSS to External Input Source"
pull down menu located on the Settings tab. Use this mode if you are using digital
S/PDIF speakers for your front speakers or wish to send the front speaker stereo
signal to an external device connected to the S/PDIF output such as a mini-disk
recorder or receiver with S/PDIF In. Please note that the volume settings on the
Settings tab will have no affect on the signal on the S/PDIF output.

Rear Left and Right Channels

In this mode the same content being sent to the rear/surround Line Out speaker jack
in analog format will also be sent to the S/PDIF output in digital format for

applications running on your PC (MP3, games, etc.). For external inputs (CD-In or Line
In), select the proper source on the "Apply Reverb/QXpander/QMSS to External Input
Source" pull down menu located on the Settings tab. Use this mode if you are using
digital S/PDIF speakers for your rear speakers. For proper operation you must also be
in 4 speaker or 5.1 speaker mode. Please note that the volume settings on the Settings
tab will have no affect on the signal on the S/PDIF output.

DVD AC3/DTS Pass-Thru

Use this mode if you wish to play DVD audio using an external AC3 or DTS
decoder such as a speaker set, receiver or decoder box connected to S/PDIF Out.
This mode is only available when using a compatible soft-DVD player capable of
streaming AC3 or DTS data to the sound card.
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EFFecTs TAB

These controls allow you to manage the application of reverb and QSound
Environmental Modeling™ (QEM™). QEM provides EAX 1.0/2.0 game compatibility
and the ability to apply reverb to non-EAX sources including applications and exter-
nal inputs.

= Philips PSC703 Audio Control Panel =i B3 |

tiities | Settings | SPOF  Effects |MIDI | seeaker Test | informatian |

—ReverbiaZound Environment Modeling —reverb Level

[ | Enahle Iﬁ W

Ervironment

I-HDI'IE- "’I

Enable or Dizable the '‘External Input’ Audio External
Reverb Level Slider on the 'Settings’ Tab Applications Irfavit
it i hep |

PHILIPS

Cloze |

Enable

When playing games supporting EAX properties select the “Enable” box under
“Reverb/QSound Environmental Modeling”. Set the Environment selector to
“- none - to avoid reverb being applied to non-EAX applications.

To apply reverb to non-EAX applications also select a reverb type using the
“Environment” selector described below and adjust the reverb level using the
slider corresponding to the source.

Environment

Using this pull down menu you can select various types of reverbs that simulate
various environments. To turn on these environments the “Enable” box must
be selected.

If you are playing an EAX 1.0 or 2.0 game it should automatically select the
appropriate environment as you move around the game. The environment selector
can be left on “-none-*.

If you are playing a non-EAX enabled game, music or movies you can select an
environment of your choice and adjust the level using the slider corresponding to
the source.

If you are using the Philips Rhythmic Edge (H/W) Synth rather than the Yamaha SXG
(default) then the “Environment” you select will also be used when playing MIDI
music and the intensity will be controlled on the reverb slider on the

MIDI tab.

Some “Environments” such as “Concert Hall” are more appropriate for music while
others like “Forsaken” were designed with specific games in mind and others like
“Drugged” are for gaming and general playing around.
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Reverb Level Sliders

These sliders, used in conjunction with the “Enable” box and the “Environment” pull
down menu, allow you to control the intensity and characteristics of the reverb effect
applied to your sound. Reverb is an acoustic effect that simulates the interaction of
sound with the environment. As an example imagine the sound of a gunshot in a
large cathedral compare to the same sound in a tiled bathroom. The entry under
“Default Environment” allows you to select a certain surrounding (environment) such
as a cave, arena or hallway while the sliders provide for control over the intensity of
the effect.

Typically very low settings should be used when adding ambiance to music or games
rather than higher settings that may cause distortion and sound unnatural.

Specifically:
Audio Applications slider:
Control the intensity of the effect for games, Sonic Foundry Siren,Yamaha SXG
Wavetable synth (also has its own reverb effect controls) and other applications.

External Input slider:
Control the intensity of the effect for analog input sources such as CD In and
Line In.

MIDI TAB

NOTE!: When your card is initially installed the SXG Softsynth is selected as your default
MIDI engine. The SXG IS NOT CONTROLLED ON THIS TAB BUT IN A SEPARATE
CONTROL PANEL. See details on the following pages

= Philips PSC703 Audio Control Panel M= |
Ltiities | Settings | S/POIF | Effects MIDI |Speaker Test | Information |
—Default MIDI Device —HiN WaveTable Yaoice
WAMAHA SHE Driver | % Better Gaming  Better Palyphony

Adjust by clicking "G Soft' lcon below —HANEveTable Reverk Level
—Wamaha SKG Setug & Rlone

]
" Global ) IU%

% As Specified in MIDI File
[Enshlerzelect Reverky on 'Effects’ Tak)

—hduttimedia Propettie —HAN WaveTable Charus Level
" Mone

]
 Global ) IU%

% &= Specified in MID! File

Click to change Default MIDI Device

Ghdthmiclecge)

_bep |
PHILIPS |

Your Rhythmic Edge™ sound card includes two distinct wavetable music synthesis
engines. The Yamaha SXG is an extremely high quality, high polyphony (512 simulta-
neous voices) MIDI synthesis engine with both GM and XG compatibility. Select the
SXG for the richest music experience. The Rhythmic Edge WaveTable Synth is a
pure hardware synthesis engine designed for use with games or other applications
were low CPU consumption is critical. Select the Rhythmic Edge WaveTable Synth
only for games that utilize MIDI for music. Note that most current PC games do
not use MIDI music so typically the SXG Softsynth can be left selected even when
playing games. These games use digital sound recordings exclusively and are not
effected by MIDI output selection.
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Default MIDI Device

When your card is initially installed the SXG Softsynth is selected as your default
MIDI engine. To view your default selection look under “Default MIDI Device” on
the MIDI tab. MIDI applications will use this default device unless they have been
specially configured to use a different device. To change the default device see
“Multimedia Properties” below. If the current default device is “Yamaha SXG Driver”
then make adjustments as indicated in “Yamaha SXG Setup” below. If the default
device is “Rhythmic Edge WaveTable Synth” then make adjustments as indicated
under the “H/W Wavetable .. ” below.

Multimedia Properties
Use this ICON to change your default MIDI device:

1. Click on the Multimedia properties icon

2. Select the MIDI tab on the “Multimedia Control Panel”
3. “Single instrument” will be selected
4

To change to a different MIDI output select it then select “Apply” or “OK”. You
can select either “Yamaha SXG Driver” (typical), “Rhythmic Edge WaveTable
Synth” (games with MIDI) or Rhythmic Edge External (if you have an external
synthesizer connected to the Game/MIDI port of the card.

Yamaha SXG Setup
To adjust the SXG Softsynth:

1. The SXG is not affected by the “H/W Wavetable” controls under the MIDI tab
of the Rhythmic Edge control panel. Instead click on the “XG Soft” Icon under
“Yamaha SXG Setup” on the Rhythmic Edge Control Panel MIDI tab.

2. The SXG can also be adjusted by right clicking on the “XG Soft” icon in the
systray (lower right corner of your screen) or in the control panel and selecting
“SoftSynthesizer Setup” .

H/W Wavetable Voices

Use this and the H/W Wavetable Chorus and Reverb Level controls to adjust
Rhythmic Edge WaveTable synth. These adjustments will have no effect on MIDI
playback unless the Rhythmic Edge Wavetable synth is selected as the MIDI device.

Better Gaming (Default, Recommended)
Best setting for Windows® DirectSound® and DirectSound3D Gaming.
Maximum hardware acceleration for games.

Better Polyphony

Setting for the highest MIDI WaveTable polyphony (most simultaneous voices). This
setting will reduce resources available for DirectSound and 3D audio acceleration
and increase CPU consumption.

You will only notice an effect if your file is high polyphony (i.e. using a large number
of voices simultaneous). For high polyphony applications you typically will want to
use the Yamaha SXG instead which has up to 512 voice polyphony.

H/W Wavetable Chorus Level
None — Chorus effect is not applied.

As Specified in MIDI File
Chorus effect is applied only as specified in the MIDI file being played. If no chorus is
specified for a MIDI voice then no change will be observed when switching between
this mode and “None” mode.

Global
Chorus will be applied to all MIDI voices regardless of the MIDI file and the chorus
intensity will be set using the slider.

H/W Wavetable Reverb Level
None — Reverb effect is not applied.

As Specified in MIDI File

Reverb effect is applied only as specified in the MIDI file being played. If no reverb is
specified for a MIDI voice then no change will be observed when switching between
this mode and “None” mode. Reverb must also be enabled and a reverb “environ-
ment” selected on the “Effects” Tab.

Global

Reverb will be applied to all MIDI voices regardless of the MIDI file and the reverb
intensity will be set using the slider. Reverb must also be enabled and a reverb “envi-
ronment” selected on the “Effects” Tab.
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SPEAKER TEST TAB

The speaker test tab is a utility to help verify proper speaker connections to your
sound card. The acronyms are defined as follows:

= Philips PSC703 Audio Control Panel == B3 |

Utiities | Settings | SPOF | Effects | MDI  Speaker Test |Infu:urmati0n |

—Output Mode —Mazter Yol

‘4

"~ Headphaone

{2 Speskers

=

R aE @
i+ 4 Speakers Lils 4P

=
o

¥ Loop Sounds

LS
Ao | Stop | ‘

Gt hmictedge)
PHILIPS

e LF — Left Front Speaker

* RF — Right Front Speaker

* RS — Right Surround Speaker
e LS — Left Surround Speaker
e LHP — Left Headphone

e RHP — Right Headphone

Cloze

LS

Select the Output Mode you wish to test.
There are two modes to test your speaker settings: Manual and Auto

Manual Mode:

Once you have selected the appropriate Output Mode, click on any of the desired
speakers to verify proper connection. You can check the Loop Sounds box that will
result in continuous sound in that speaker. Click the Stop button to stop

the test.

Auto Mode:
Click on Auto Mode. Sounds will emanate in sequence starting with LF and cycle
through each speaker in the Output Mode you selected.

Use the Master Volume Slider to adjust the overall output level of your
speaker system,

Adjust speaker connections as required to complete your sound card installation.
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INFORMATION TAB

The information tab provides detailed information about your sound card. This
includes the model number for your product and software version information.

= Philips PSC703 Audio Control Panel | =) x| |

tiities | Settings | SPDF | Effects | MIDI | Speaker Test  Information |

Philipz PSCF03 4-Channel PCl Audio Cwith Digital Cutput)

Model Mumber: PSCF03
Manufacturer: Philips Consumer Electronics Company

—'ersion Information
Inztallation Software Werzion: PSCTO3WIRAR V221 (Englizh)
Update Software Yersion: Mo Updates Applied

Wersion Titme Stamp Size

Aydio Driver DRY: 4051174 0012271556 197024

Aydio Driver %¥O: 4051134 0012261724 482032
Jowestick Driver WHD: 4051006 9907200313 19335
“irtual Device Driver %®D: 4051011 9910251640 17030

Ehagthmicedge)

_tob |
PHILIPS |

DVD Playback Modes

Using 4-channel surround speakers your Rhythmic Edge™ sound card can deliver
true multi-channel surround sound from a compatible soft-DVD player

application even if the player only supports stereo output. If the soft-DVD player is
capable of providing a 4-channel Dolby Digital™ down-mix Rhythmic Edge will out-
put all 4 Dolby Digital channels. Even if the soft-DVD player supports 4-channel
Dolby Digital™ you may prefer using QMSS™ playback of DVD's because of the
enhanced rear channel content it provides. If you have only stereo speakers Rhythmic
Edge can also provide virtual surround using its QSurround feature.

To enable 4 speaker QMSS™ DVD enhancement:

1

a &~ DN

Make sure “4 Speakers” (and "Expand All" for Windows® 2000) is selected in
the Rhythmic Edge control panel settings tab.

Open the “control panel” or “settings” menu for the soft-DVD player.
Select the menu or tab that controls the player's audio settings.
Look for a panel that allows you to select the number and type audio channels

Select either 2 speaker “Stereo” or 2 speaker “Dolby Surround or ProLogic”.
Either option will work well as the QMSS™ DSP algorithm does not depend
on Dolby encoding. (Effectively you should follow the soft-DVD player
instructions for playing back over stereo speakers even though you have a quad
speaker system connected).

Close the control panel and play a DVD. Rhythmic Edge will detect that it is in
4 speaker mode but is only receiving two channels of audio from the DVD and
automatically generate 4 distinct channels of surround sound using QMSS™.

To enable a 4 speaker Dolby Digital™ playback :

1

Make sure “4 Speakers” is selected (and for Windows® 2000 that "Expand All" is
NQT selected) in the Rhythmic Edge control panel settings tab.

Follow the soft-DVD players instructions for 4 speaker playback. (Some players
will not offer this feature)

Play a DVD and Rhythmic edge will output the 4 channel Dolby Digital sound
provided by the soft-DVD player.
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Rhythmic Edge supports Microsoft’s standards for multichannel playback however
some soft-DVD players may not. If this mode does not work with your soft-
DVD player then use QMSS DVD enhancement mode described in the
preceding section.

If you only have stereo speakers:
1. Make sure “2 speakers” is selected in the Rhythmic Edge control panel
settings tab.

2. Select “DVD QSurround” under “2 speakers” in the Rhythmic Edge
control panel.

3. Follow the soft-DVD players instructions for “5.1 speaker” playback. [If your
soft-DVD player does not provide a 5.1 speaker mode then select “QXpander”
instead of “DVD QSurround in line 2) above and follow the soft-DVD players
instructions for “stereo” playback instead]

4. Play a DVD and Rhythmic Edge will virtualize surround effects coming from
the DVD.

ABOUT SIREN™ XPRESS

Transform your PC into the ultimate music entertainment center with SIREN XPress
music jukebox. SIREN XPress lets you “rip” your CD collection onto one convenient
location—your hard drive. Let SIREN XPress help you surf the net and find more
great music to add to your collection—MP3, WAV, and WMA files are all supported.
Use SIREN XPress' advanced organizational features to create custom playlists of the
songs you want to hear. SIREN XPress maximizes your audio experience with daz-
zling, colorful eye candy—real-time computer animation that pulses and interacts
with your songs. And when you're ready to hit the road with your portable MP3
player,* SIREN XPress is the fun, easy way to upload your custom playlists.

* Supported MP3 players do not currently run under Windows NT or Windows 2000.
You must be running SIREN XPress on Windows 9x to upload songs to portable players.
SIREN XPress includes 20 free MP3 encodes, with unlimited MP3 playback.

SIREN XPress makes it easy to organize your music:
e SIREN XPress includes a powerful, database-driven music management engine.

e The Sort, Group, and Filter tools provide you with superior control over your
music library.

About SIREN™ XPress

» Use the Field Chooser window to view your collection the way you want
to see it.

SIREN XPress brings powerful functionality to your desktop:
e Use Search for Music to find music on a network or removable drive.

e Export custom playlists to your Rio or Nomad Il portable MP3 device.

= Use your Microsoft Internet Keyboard hotkeys to control SIREN
XPress's functions.

Siren™ XPress Quick Start

Welcome to Sonic Foundry's SIREN XPress! This guide is designed to provide you
with information that will allow you to immediately begin taking advantage of the
powerful features of SIREN™ XPress.

SIREN XPress allows you to operate in Philips compact mode or normal mode. The
compact mode includes only the Transport buttons (Play, Stop, Pause, etc.). Normal
mode displays the entire SIREN XPress window, and allows access to all SIREN
XPress functionality. You can toggle between the Philips compact mode and normal
mode using any of the following methods:

e Click the Compact/Skin Mode button.
* From the View menu, choose the Compact/Skin Mode option.
e Press Ctrl + M on your keyboard.

You can expand the Philips compact mode to display the current and next songs, the
Compact/Skin Mode button, and the Select Playlist button.To expand the compact
mode, click the Expand control on the right end of the player.You can also use this
control to collapse the compact mode. The SIREN XPress expanded compact mode

is shown below:
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About SIREN™ XPress

Media Files

A media file refers to any audio and video file that SIREN will play from your com-
puter. SIREN supports the following media file formats: .wav, mp3, .wma, .pca, .aif,
.0gg, .avi, wmy, .asf, .mpg, .mpeg, .mov, .qt.

Finding Media

After you install SIREN XPress, a configuration wizard will scan your local hard drives
for any .mp3 and .wma files and add them to your SIREN XPress media library. If
you are unable to play media or use the transport controls for SIREN XPress after
the installation process, you can manually run the Configuration Wizard from
SIREN's normal mode by choosing Configuration Wizard from the Options menu.

You can also search your hard drive(s) for media to add to your media library any
time by choosing Search Computer for Media from the Options menu.

Playing Media

SIREN will allow you to play .mp3, wma,wav , .pca, .aif, .0gg, .avi, wmy, .asf, .mpg,
.mpeg, .mov, and .qt files, as well as audio CDs. You can start playing media
immediately by clicking on the Play button in either compact or normal mode.

Playing media by type

With the compact mode expanded, click on the “Play Media from” button. From the
menu that displays, you can select your media by library views, album, artist, genre, or
playlist, or choose to play an audio CD.

GRAPHIC EFFECTS

SIREN XPress displays dazzling visual effects during audio playback. SIREN XPress
defaults to the special Rhythmic Edge visual which represents the six distinctly different
channels of sounds generated by the Rhythmic Edge. With this effect selected you
will see up to six dots, one corresponding to each speaker channel pulsating to the
sound coming from the corresponding channel. For example in 4 speaker mode you
will see these four dots:

Top left dot - left front channel
Bottom left dot - left rear channel

Top right- dot - right front channel
Bottom right dot - right rear channel

In 2 speaker or earphone mode you will see two dots. You can also select other
effects patterns by right-clicking on the visual display and choosing from the list of
available graphic effects”

RIPPING (RECORDING) FROM A CD
1. Place an audio CD in your computer'’s CD-ROM drive.

2. In normal mode, select the Play/Rip CD tab (from the Media Manager
panel). Your computer’s CD drives are displayed on the Play/Rip CD page.

3. Specify the CD drive containing the audio CD (from the drop-down list located
above the track list). The CD’s tracks are displayed, and SIREN attempts to
access information for the CD. If the CD information does not appear, you can
obtain the CD information by clicking the CDDB button, or you can add the
information manually in the Play/Rip CD page. If the CD information is not
accessed or added manually, SIREN rips the songs as “Unknown” and numbers
them sequentially.

4.  Select the song(s) to be ripped.

5. From the File menu, choose Rip to Library. SIREN begins ripping files to the
folder specified in the Preferences dialog, and a meter in the Status column
depicts the progress of the ripping.

6. To halt ripping at any time, choose Cancel Ripping from the File menu.

7. To monitor the ripping progress, select Encoding List from the Play/Rip CD
page drop-down list, or, if Tree View is enabled, double-click on the Encoding
List folder.

Note:You can play media from the media library while you are ripping CDs, but you
cannot listen to the CD itself during ripping.

ADDITIONAL HELP

For more detailed information about SIREN XPress features, please refer to the
online Help file accessible from SIREN'’s normal mode by choosing Contents and
Index from the Help menu.

For additional information on other Sonic Foundry products, visit
www.sonicfoundry.com.
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About Audio Pixm

UPGRADING TO SIREN JUKEBOX

If you like SIREN XPress but want more powerful options, upgrade to Sonic
Foundry’s SIREN Jukebox:

e CD burning

e Unlimited MP3 ripping

= Advanced audio effects

* Perfect Clarity Audio encoding

= Higher bitrate WMA encoding

To upgrade, choose Instant Upgrade from the Help menu.

ABOUT AUDIOPIX™

AudioPix™ makes it easy to combine digital images with MP3 sound to get the ulti-
mate multimedia presentation. In just three simple steps you will have an exciting
new MPEG format that can be played back in either of the popular players,
RealPlayer® or Windows Media™ Player. Now for the first time, you don't have to
be a Web Master to create your own unique presentations — just grab an MP3 file,
some of your most treasured images and let your imagination go.

< Turn your wedding photos and special occasions into a creative slideshow for
friends and family

= Keep your vacation memories alive forever. Go on vacation without going on
vacation!

= Create an “Internet Commercial” to promote your business
To install AudioPix, follow these simple steps:
1. Insert your install CD into your CD drive

2. Go to D:\Applications\QSound Labs\AudioPix\ (D represents your
CD-ROM drive)

3. Double click on apixfree.exe

4. Follow the on-screen instructions for installation. The required serial number is
located at D:\Applications\QSound Labs\AudioPix\. Open the apixfree.txt file.

Recording Source Configuration

Philips Rhythmic Edge™ allows you to record sounds and music from various input
sources (i.e. microphone, audio CD, line in, etc). Before you start recording, you need
to configure the recording source as follow:

* Open the Volume Mixer, go to Options, and select Properties.
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Recording Source Configuration

e Choose "Recording" under “Adjust Volume for”, and check the recording source
that you want to display in the Recording Mixer.

 Click OK, and the Recording Mixer window will open. Now you can select the
recording source you intend to use and adjust the recording volume level.

Properties EE
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* Open your favorite recording application and start recording.
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Resolving 1/0 Conflicts

Conflicts between your audio card and another device may occur if they are set to
use the same I/O address. To resolve I/O conflicts, change the resource settings of
your Philips Rhythmic Edge™ card or the conflicting device using Device
Manager in Windows® 95/98,

If you are still unable to determine which card is causing the conflict, remove all cards
except the Philips Rhythmic Edge™ card and other essential cards (for example,
disk controller and graphics cards). Add each card back until Device Manager indi-
cates that a conflict has occurred.

To resolve conflicts in Windows® 95/98

1. Click the Start button, point to Settings, and then click Control Panel.
2. In the Control Panel window, double-click the System icon.

3. In the System Properties dialog, click the Device manager tab.
4

Under the Sound,Video and Game Controllers entry, select the conflicting
audio card driver, indicated by an exclamation mark (!), and click the
Properties button.

In the Properties dialog, click the Resources tab.
Select Use Automatic Settings and click the OK button.

Restart your computer to allow Windows 95/98 to reassign resources
to the devices.

UNINSTALLING SOFTWARE DRIVERS

Windows® 95/98/Me Uninstall
1. Select Control Panel, Add/Remove Programs and select Philips Rhythmic Edge
Audio Support Files. Click the ADD/REMOVE button.

2. You will be prompted to shutdown your computer after uninstall for the
changes to take effect. Click Yes to shutdown your computer and then remove
Philips Rhythmic EdgeTM from your system.

Windows NT® Uninstall

Browse to the Multimedia page in the Control Panel, click on the “Devices” tab,
under “Audio Devices” select “Philips Rhythmic Edge Audio”, and then click the
“Remove” button. Shutdown your computer and remove Philips Rhythmic Edge™
from your system.

Uninstalling Software Drivers

Windows® 2000 Uninstall

Open the Add/Remove Hardware control panel applet

Select “Uninstall/Unplug a Device”. Click Next.

Select “Uninstall a Device”. Click Next.

Choose Philips Rhythmic Edge Audio from the list. Click Next.
Click Yes on confirm screen. Click Next.

Open the Add/Remove Hardware control panel applet

Select “Uninstall/Unplug a Device”. Click Next.

Select “Uninstall a Device”. Click Next.

© o N o g &~ w D PP

Choose Philips Rhythmic Edge Game Port Enumerator from the list. Click Next.
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Click Yes on the confirm screen. Click Next.

[EN
=

Open the Add / Remove Programs control panel applet
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N

Click on Philips Rhythmic Support Files. Click Change/Remove.

[N
w

Power down your computer and remove your sound card.
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Notes:



